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Install Xilica Designer 

The Xilica Designer software provides optimum configuration of X2, Solaro and Neutrino Series 
processors and it also configures Xilica’s programmable remote controls, configures and manages 
any networked Dante device, and provides universal third-party device control integration.

Mac OS X Installation 

System Requirements
Mac OS X 10.8 or later
Processor 1GHz or higher
500MB of available space
1GB graphics card
4GB RAM 
 
1.     Download the latest version of Xilica Designer from the Xilica website (www.xilica.com).  
2.     Open the downloaded .zip file. 
3.     Then open the XilicaDesigner.mpkg file. 
4.      An installation window will appear. Read and follow each step to proceed.

5.     Once completed, the installation window will display: The installation was successful.

6.     The Xilica Designer software is now installed.
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Windows Installation 

System Requirements
Windows 7 or higher 
Processor 1GHz or higher
500MB of available space
1GB graphics card
4GB RAM

1.     Download the latest version of Xilica Designer from the Xilica website (www.xilica.com). 
2.     Open the downloaded .zip file.  
3.     Then open the XilicaDesigner.exe file. 
4.      An installation window will appear. Click Install to continue.

5.     Allow the program to complete the installation process. This may take a several minutes.
6.     When complete, Windows will ask for permission to allow firewall access. The suggested 
        setting is to allow Xilica Designer to communicate in Private networks, such as home or work. 
        Allow access to public networks at your own discretion. Check the appropriate boxes, then 
        click Allow Access to finish.

7.     The Xilica Designer software is now installed.
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Launch Xilica Designer 

Locate the Xilica Designer application on your Desktop or Applications folder.
Double click the application to launch the software.

You can create a New Design Project, Open Design Project, Start Network View, or Start Dante View.  

Network View  
 
Network View displays all processors and control devices on the network. Network View displays 
device information including, the device connection status, computer IP address, device IP 
address, device name, manufacturer and the firmware version.

In Network View, you should see your processor(s) listed. At the top left of each device block is a 
device connection indicator. 
 
Green:      The device is connected and operational. 

Yellow:     The device is connected and online, but not operational. Hovering over the network  
	        indicator will display a pop-up message of identified problems. (Normally this would  
	        indicate that no device design is loaded). 

Red: 	        The device is not connected and offline. There is no communication between Xilica 
	        Designer software and the device. Please check all cables, connections and power. If the  
                   processor is performing a firmware upgrade or is in the process of rebooting, this may  
	        be a temporary offline interruption.
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Note: DHCP enabled Router/switch gear should be turned on first, with all Ethernet cables 
connected to the hardware prior to Powering ON the hardware. This will allow for proper IP 
address distribution to the Hardware. 
 
 
 
 
 
 
 
 
 
 
 
 
First, Power ON the router/switch gear. 
Then connect an Ethernet cable from the host computer to the DHCP enabled router. 
 
Connect an Ethernet cable from the router to the Solaro device. 
Then connect the external power supply to the Solaro device.

Switch ON the processor device.

A) Connecting using a DHCP enabled router/server 

B) Non-DHCP direct connection or indirect connection 
 
Non-DHCP connections are not automatic. Non-DHCP connections must be manually configured. 
Please refer to Xilica Designer help file or Xilica FAQ for further assistance.

Connecting to other hardware devices 
 
Dante™ connectivity is accomplished using an RJ45 (Ethernet) cable.

Other connections are determined by the selected I/O cards. Please refer to the Xilica website for 
card information.

Note: Turn off your computer’s Wi-Fi so the device can connect to the appropriate network.
If the device displays a yellow network indicator in Xilica Designer’s Network View, perform a 
device IP Reset and reboot the software.
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Non-DHCP Connections / Indirect Connections

When the processor is connected directly to a computer or indirectly via a switch or hub and DHCP 
is not available to assign IP addresses, the connection process is not automatic.

Once no DHCP is detected, the processor will either try to connect using the IP address last 
assigned and stored on the device or attempt to revert to its default IP address. Under some 
conditions the processor may refuse to revert to its default IP address and refuse to connect. We 
recommend performing an IP Reset first. 

IP Reset / Reset Device Network Settings 

1.     Power down the unit. Hold down the IP Reset button located at the back of the processor and  
        power up the device.

2.     Wait 5-10 seconds after power up until the device LEDS begin to flash, then release the IP  
        reset button.

3.     Allow the processor to launch completely.

4.     Open the Xilica Designer software on your computer and start Network View.

Manually Configure Network Settings

1.     In the Network View, right click the device block and select Device Setup.

2.     In the Network tab, click Change Network Configuration and disable DHCP.

3.     Set the device IP Address to be the same first 3 group of digits as your computer IP Address  
        but change the last group of digits. (Ex. Computer IP Address: 192.168.1.254 , Manual Device  
        IP Address: 192.168.1.XXX  - where X is any value from 0-254)

4.     The Subnet is: 255.255.255.0

5.     The Gateway is the same first 3 groups of digits as your computer Address with the last  
        number being 1. (Ex. Computer IP Address: 192.168.1.254 , Device Gateway is: 192.168.1.1)
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6.     Once done, click Apply to save your settings and Done to exit out of the window. 

7.     Your devices should now appear online and connected. If your device is not connecting, try  
        rebooting the Xilica Designer software and your device.

For multiple devices, Repeat steps 1-6 for each subsequent processor but change the last 
digit in the IP Address so each device has its own unique IP Address. (Ex. 192.168.1.100 
/102/103/104/105...) Once completed, your devices should now appear online and connected. If 
your device is not connecting, try rebooting the Xilica Designer software and your device.
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Assigning a Static IP Address to your Computer 

Windows Platform

1.     In the start menu, select control panel.
2.     Click Network and Internet. Under the heading Network and Sharing Center, select View  
        Network Status and Tasks.

3.     Click on Change Adapter Settings on the left tab.

4.     Select Local Area Connection and click on the Properties button. Select Internet Protocol  
         Version 4 (TCP/IPv4) then Properties to access the manual IP settings. 

5.     Set up your computer’s IP address to be 192.168.1.X where X can be any value from 0-255,  
        but unique from other manually assigned device IP addresses.

6.     Use the following settings for your PC’s unique static address:	
        IP address: 192.168.1.X (X is any value from 0-255 but unique from other device IP addresses)
        Subnet mask: 255.255.255.0
        Gateway: 192.168.1.1
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Mac Platform

1.     From the Apple menu, select System Preferences. 

2.     Select Network.

3.     From the sidebar, select the Network interface that you are using. Then click Advanced...

4.     In the TCP/IP tab, set Configure IPv4 to Manually using the drop down menu. 

5.     Enter a static IP address in the IPv4 Address field. Set up your computer’s IP address to be 
        192.168.1.X where X can be any value from 0-255, but unique from other device IP addresses.

6.     Use the following settings for your computers static address:	
        IP address: 192.168.1.X (X is any value from 0-255 but unique from other device IP addresses)
        Subnet mask: 255.255.255.0
        Gateway: 192.168.1.1

7.     Click Ok and Apply to apply your changes.
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Connection Troubleshoot 

If the connection status indicator in Network View is yellow, hover your cursor over the indicator 
and a pop-up message will identify the problems detected.

Device Not Ready
The processor needs a design loaded to the unit. If the same error message persists after a design 
is loaded, restart the processor and the Xilica Designer software.

DSP Processing Error
Retry reloading the pre-designed DSP app schematic. 
If the indicator is still yellow, restart the processor and the Xilica Designer software.

Error in Firmware Upgrade
The pop-up message shown will print out an error code. Retry the Firmware Upgrade. 

Device can communicate with UDP but cannot communicate with TCP
1.     Right click the device in Network view and select Device Setup. Select the Network tab.

2.     Click TCP Test/UDP Test to test TCP/UDP connections.
3.     If failed, please check your computer’s firewall and router settings. Also ensure that Wi-Fi is  
        turned off.
4.     Click Start Network Statistics to see network statistic information. 
5.     Restart Xilica Designer and review your device connection.
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At times you may just see an exclamation mark (!) in Network View. This indicates that a firmware 
upgrade is available. Normally this is not an issue unless there are updated modules in the project 
file that the outdated firmware does not support.

Firmware Upgrade

Please note that using an older version of software with a newer firmware or newer software with 
an older firmware will work but some of the features may not be available and bugs could exist.  
We recommend upgrading the software and firmware to the latest versions. 
 
Before you begin, check your software and firmware versions.

To check the current device firmware version, make sure that your device is connected and online. 
In Network View, devices that have a Firmware Upgrade available will display a yellow triangle with 
an exclamation mark. The device Firmware version is also listed in the device block.

To view the current software version, click on the About tab at the top of the software.

 
Matching the Firmware 

To assist you in determining which firmware file is appropriate for your device, refer to the chart 
below. Note: The file structure may be different from the date that this list was created. Always 
check the Xilica website (www.xilica.com) to keep updated.

#_#_# Represents the 3 digit version code of the firmware update.  

(SOLARO_#_#_#.img)	 	 Solaro QR, FR
(X2_#_#_#.img)	 		  X2
(XIO_#_#_#.img)			   XIO8, XIO16
(XTOUCH_#_#_#.img)		  XTouch50, XTouch80 
(NEUTRINO_#_#_#.img)		 Neutrino A, A-D (AES), A-N (Dante), A-ND (Dante, AES)
(UNO_#_#_#.img)	 	 Uno-U, U-D (AES), U-N (Dante), U-ND (Dante, AES) 
(NEUTRINO-AEC_#_#_#.img)	 Neutrino AEC
(UNO-AEC_#_#_#.img)	 	 Uno AEC 
(RIO_#_#_#.img)	 		  Rio-N, NX
(NEUPANEL MINI_#_#_#.img)	 NeuPanel Mini K1, K4, S4, S8, S4K1
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4.     A pop-up warning will appear stating that the Firmware Upgrade process will erase all data  
        from your device. Click OK to proceed. 

Firmware Upgrade Procedure: 

Save any design files from the device onto your computer as all programmed data on the device 
will be erased during the upgrade process. After the firmware upgrade is completed, the design 
file can be loaded back into your device.

1.     The device must be online and operational (green ON indicator) to perform a firmware upgrade. 
 
2.     Download the latest firmware version for your device from the Xilica website (www.xilica.com). 

3.     In Network View, right click the device block and select Firmware Upgrade.
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5.     Navigate to the file in which you downloaded the new Firmware file. Click Open.

6.     A status bar in the device window will monitor the Firmware upgrade progress. 

Once the Firmware file has been loaded to the device, the device will automatically restart and 
update its internal data. This may take several minutes. During this period, the device network 
indicator will turn RED and appear offline.  
 
DO NOT POWER OFF THE DEVICE. Powering off the device during a Firmware Upgrade can 
result in a complete corruption of the processor. If this happens, a USB Firmware Recovery must 
be completed. (Please refer to Xilica Designer help file or Xilica FAQ for further assistance). 
 
Once the firmware upgrade is completed, the device will display a green ON indicator. 
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Firmware Recovery

A firmware recovery is needed when the device O/S is corrupted. (Ex. if device is powered OFF 
while device is performing a firmware upgrade.)

The full firmware recovery process will take up to 40-50 minutes to complete.

USB Firmware Recovery

Save any design files from the device onto your computer as all programmed data on the device 
will be erased during the recovery process. After the firmware recovery is completed, the design 
file can be loaded back into your device.
 
1.     Download the latest firmware version for your device from the Xilica website (www.xilica.com).

2.     Holding the IP reset button, power ON the device. The device will be booted in recovery 
        mode. Under this recovery mode, the blue power LED will begin flashing in a special pattern.     
        The device will quickly flash 8 times in one second and then off for another second.

3.     Open the Xilica Designer software and start Network View.
        The device must be online and operational (green ON indicator) to perform a firmware recovery. 

4.     Click on the device block to highlight it. 

5.     In the Device Management tab, select Solaro USB Firmware Recovery > CPU Board Firmware 
        Recovery. (Note: Xilica Designer projects must be closed for this function).

6.     Follow the onscreen instructions to perform the USB Firmware recovery.

7.     Once complete, the device will automatically reboot. At this stage, the process is only half 
        complete. The device will appear in Network view in Recovery mode. In this mode, the 		
        only action available is to perform the second half of the recovery.

8.     Right click on the device block and select Firmware Recovery.
        
9.     Select the downloaded firmware file (From step 1). The device will then perform the  
        second stage of the recovery. This will take approximately 5 minutes. Do NOT power off the  
        device.

10.   The device will automatically reboot once the recovery process is completed.
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Project View 

You can create a new project in one of two ways:

Auto-configuration 
 
If your device is listed in network view, select your device and click Create New Project with 
Selected Device(s) at the top right of the software. This will create a project with your processor.
 
 
 
 
 
 

Blank project 
 
Alternatively, click File > New Project.  
When creating a blank project, Xilica Designer will ask you which DSP series you are using. Select 
the appropriate option.

1.     Component Library Menu
          This menu displays a list of devices and design modules that you can use in your project. 

2.     Work Area	  
          The work area provides a space to design and configure devices. 

3.     Object Property Menu 
          This menu allows you to customize the object properties in the design.
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Create a Design

For the example, a single DSP hardware block will be used, but a design can be done with multiple 
DSP hardware items.

Projects can be designed Offline (no devices connected) and the design can be loaded to your 
devices at a later time.

1.     From the Component Library, drag & drop the DSP module onto the work area.

2.     An Option Card Configuration box will appear. Use the drop down menus to customize your  
        Solaro DSP device and click OK when complete. 

Note: The device card configuration must match the hardware card configuration. Mismatched 
cards will not have any functionality. I/O cards can be reconfigured using the Object Property 
Menu.  
 
3.     The Solaro device will be configured accordingly.
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4.     Select the DSP module to highlight it. In the Object Property menu, the device properties can  
        be customized. Note: Object Properties vary depending on the object selected. 
 
 
 
 
 
 
 
 
5.     Double click the DSP module to open the design schematic. Resize the window by dragging  
        the corner of the window.

6.     To space out your work area, click & drag a selection box around the output modules and use  
        the cursor arrows or mouse to move the modules to the right.

When this window is selected, the Component Library menu displays a variety of DSP modules. 
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7.     Click and drag a DSP module into the device schematic window.

In the example, a PEQ was added.  
 
8.     In the Object Property menu, you can customize the module.  
        For the PEQ module, up to 8 bands are available. 
 
9.     Double click the DSP module to open it. 
        In the PEQ module, the number of bands determined in the object property menu is reflected  
        in the DSP module.

10.     From the input module, click & drag a wire to the DSP input node.
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11.     Drag & drop more DSP modules, then wire them accordingly.

Processing chains and objects can be easily duplicated by selecting the desired object(s), 
Ctrl + C to copy, then Ctrl + V to paste the items.

When drawing wires, they may overlap and be difficult to read.

To move wires, click & drag the corner of a wire,
or highlight the wire and click & drag the red corner node. 
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12.     To save your project, click File > Save As. Save the file to a memorable location.  
           If a project file is already created, click File > Save. You can also save using the save icon at  
           the top right of the work area. 
 
 
 
 
 
 
 
 
 
 
It is recommended to back up project files to an external location. 
 
Saved project files will have a .pjxml extension at the end of the file name. 
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Going Online 
 
Going online loads the design file to the connected device(s) and allows you to make adjustments 
in real-time.  
 
In order to go online, all devices must be connected and online. (Green ON indicator in Network View)

To go online, you must associate the device module with the physical hardware device.

1.    In Project View, select the device module you would like to map.

2.    Right click the device module and select Map to Physical Device. 
 
3.    Detected devices with their Mac Address will list. 
       If there is more than one of the same devices in the network, the devices can be identified by  
       the Mac Address. The device Mac Address can be found in Network View.
 
It is very important that the name of the device block in the design file matches exactly to the unit 
in the Network View, otherwise you will not be able to load the design to the physical device.
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Once mapped, the module will become a solid grey color and the device Mac Address will display 
at the bottom of the device module.

4.     Click Load Design to Device(s) located at the top of the work area.

5.     A window will pop up. Check the devices that you would like to load your design to.    
         Then click OK. 
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Going online may take up to several minutes. Please do not disrupt the process. The progress bar 
at the top will display the overall progress percentage. 

Once online, notice that the work area has become a solid color and the design menus are no 
longer available.   

6.     To make adjustments in real-time, double click the DSP module in Project View, 
        Or double click the device block in Network View to view the device schematic.
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7.     Double click any DSP module or I/O block to make adjustments.

Switch back to design mode at any time using the Go Back to Design Mode button located at the 
top of the work area. 

You will be asked if you’d like to copy the adjustments made online, back into the project design.

Click Yes to transfer the settings made online into the project.
Click No to revert back to the previous design file. 
 
If online settings are transferred into the project, File > Save will overwrite the original project file. 
File > Save As will create and save a separate project file. 
 
It is recommended to back up project file(s) to an external location.
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Presets

Global Presets 

Global presets allow the user to recall saved settings for all devices in the system.

1.     Drag a selection box around all devices. With the devices highlighted,  right click on a  
        device. 
 
2.     Select Copy Device Values to Preset > Create New Preset. 
 
3.     The preset will automatically be saved in the first available preset slot. You can rename the  
        preset and also choose to Mute Device during Preset Action.

4.     Click Ok to save your settings. 

Module Presets 

Module presets allow the user to recall saved settings for an entire module.

1.      Select the module. Then right click on the module. 

2.     Select Save Module Values to Preset > Create New Preset. 
 
3.     The preset will automatically be saved in the first available preset slot. You can rename the  
        preset and also choose to Mute Device during Preset Action.

4.     Click Ok to save your settings. 

Individual Item Preset 

Item presets allow the user to recall saved settings for selected parameters within a module.

1.     Open the DSP module and select the parameters you would like to save using Ctrl + Click.
 
2.     Right click and select Save Module Parameters to Preset > Create New Preset.

3.     Choose the preset slot and name the preset. Click Ok to save your settings. 



  
27

Add To an Existing Preset 

Highlight the device/module/item, Right click and select Save Module Parameters to Preset. Then 
select the existing preset you wish to add the new items to.
 
 
 
 
 
 
 
 
 
 

Trigger Presets 

At the top of the software, next to the heading No Active Preset is a drop-down menu. 

Select your desired preset to activate it. Devices/Modules/Items inside of an active preset will be 
highlighted in red.
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View All Saved Presets 

Navigate to the top left Project tab then select Project Presets. 
 
 
 
 
 
 
 
 
 
 
 
 
 

A window will pop-up with the list of all saved project presets.  

You can view preset details which lists all parameters saved within the related preset, copy presets, 
delete presets or rename presets. You may also select Mute during apply to avoid potential pops/
clicks when the preset is activated.  

Click Done to save your changes.

In this window you can view the 200 available presets. 
The red box highlights presets that can be controlled by GPIO inputs.
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Create a Blueprint 

A Blueprint can be used for documentation, submittals, and handed to an installation technician for 
use on the job site. Blueprint information can include wire identification/type, equipment names 
and locations, including notes for the job.

1.     Drag and drop the devices needed for your design. Click and drag the corner of the module    
        to resize the objects.  
        In the example, a Neutrino DSP and three User Defined Devices were added to the work area.

2.     Select a device. With the device highlighted, you can change the Object Properties using the  
        menu on the right. 
        For the example, we will change the properties of the User Defined Device to replicate a  
        microphone.
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3.     Since our example includes eight microphones, we will duplicate this module.
        To duplicate an object, right click the highlighted object and select Copy. Select the dotted 
         work area and click Paste. You can also copy multiple modules at once.

4.     For the next User Defined Device, we will create a background music source. Similarly,  
        adjust the object properties using the menu on the right.

5.     Lastly, the third User Defined Device, will be two speakers. Adjust the object properties.
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6.     To connect device modules together, simply click and drag from an output node to an input 
        node. This will create a wire.

        You may need to adjust the wires. Select the wire and use the red nodes to adjust the wire  
        path. You can also select multiple wires and adjust them as a group.

7.     Wires can also be named and labelled using the Object Property menu. 
        Select a wire and change the Cable Information. The wire will be labelled accordingly.
        Source Label labels the input of the wire. Dest. Label labels the wire destination.
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8.     In the Component Library menu, add Drawing Elements, including: labels, shapes and lines to 
        complete the Blueprint.

9.     At the bottom right of the work area displays a Project information box. Double click this box.

Edit the project information and click Done to save your changes. 
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Export design to Jpeg or AutoCAD 

At any point in the design process, you have the ability to print a copy of your project as a .jpg or 
.dfx image file.

At the top of the software under the Project tab, select Export Project Design Drawings… 
This will print a jpeg image of the project view at a resolution of 1800 x 1200 pixels. 
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Export Bill of Materials 

Bill of Materials generates an organized document listing all physical cabling and hardware 
description required for your project. Elements such as CD Players, microphones, amplifiers, and 
speakers, all play an important part in the compilation of the bill of materials. 

Under the Project tab, select Export Bill of Materials.  
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Dante® View 
 
At the top right of the software, switch to Dante View.
Please note that your devices must be connected and online (Green ON indicator in Network View) 
to be seen in Dante View.

 
 

Connections made in Project view will display the connections are automatically wired in Dante view.

Connected Dante devices will display as a list on the left.
Device Dante routing is configured on the right. To route devices, click on an available input/output 
space where the devices intersect. Connections are displayed as a green square.
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If there are multiple Dante device, you can reorder devices by dragging the device block. 
 
To view device settings, right click the desired device block, and select Dante Device Setup. 

The first Dante tab displays product model information.

The next Dante Network Setup tab displays your Dante device network information.
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Dante Config tab allows you to configure your Dante device.

Dante Channel set up allows you to rename input and output channels. You CAN also mute 
channels.

Once done reviewing you device settings, click Done.
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GPIO Guide
 
The term GPIO refers to the sequence of operations and conditioning required for a specific action 
to be performed. GPIO operations are programmed within Xilica Designer through the use of 
wiring and modules. 

GPIO capabilities allow for added functionality such as: emergency mute, contact switch input, LED 
display, Preset triggering, GPIO controlled mute, and more. 

The GPIO card can serve as 3 functions: an input card with basic logic contact closure functions, 
an input card with voltage, or an output card.

The GPIO input card can serve as Logic GPIO or Voltage GPIO. The card cannot have both 
functions.

Specifications
 
GPIO Card - Input mode
Number of inputs		  4
Input type			   GPIO (software selectable per input)
Logic GPIO			   Short to ground to activate
Voltage GPIO		  Can sense 0-24V DC, can provide 12V DC
Connectors			   6 position Phoenix plug-in 3.81mm type

GPIO Card - Output mode
Number of outputs 		 4
Output type			   LED/Source sink (software selectable per channel)
LED				    3mA per output
Source sink			   300mA per output
Connectors			   6 position Phoenix plug-in 3.81mm type

12V
Ch #1
Ch #2
Ch #3
Ch #4
Ground
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Creating a GPIO Design

In this example, the Solaro device uses 3 GPIO cards, configured as GPIO input, GPIO Voltage 
input, and GPIO output. The diagram above is a visual representation of the GPIO design.

The GPIO inputs used include a basic on/off switch, an air-wall contact closure using two logic 
connections, and a 10k potentiometer.

The GPIO outputs use a single output logic card.
Pin #1 will light an LED.
Pin #2 will turn a power sequencer on/off.
Pin #3 & #4 will raise/lower a screen. 
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Double click the device to open the device schematic. In the Component Library menu, a Logic 
sub-menu lists available GPIO modules.

Make sure your cards are displayed in the design.

The GPIO Input Card must be connected to the GPIO Input block.
The GPIO Voltage Input Card must be connected to the GPIO Voltage Input block.
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Open the GPIO Input block to view parameters. The GPIO Input block allows you to enable it or 
invert it.  No parameters are available for GPIO Voltage input.

The GPIO Output block must be connected to the GPIO Output Card.

Open the GPIO Output block to view parameters. The GPIO Output block allows you to enable it 
or invert it.

The GPIO Output Card parameters allow you to select Sink/LED mode.

The Action Trigger Module allows you to trigger project presets.
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Basic Contact Closure  SPST

In this example, we will create a basic On/Off switch that will Mute the audio.

First, wire the physical On/Off switch to the GPIO Card, using the image above for reference.
 
In the software, wire the GPIO Input Card to the GPIO Input block. From the GPIO Input block, 
connect a Logic Controlled Mute - and run all audio through the Logic Controlled Mute. 

Then wire out to a Matrix Mixer followed by the Audio Output block and Analog Audio Output 
Card. 

To mute an entire system, increase the nodes on the Logic Controlled Mute. To do this, select the 
module and configure the nodes in the Object Property menu. Then tie into other audio sources 
that need to be muted.  

GPIO Inputs
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In this example, we will trigger a preset when the door closes and another when the doors open.

First, wire the physical Magnetic Contact Closure to the GPIO Card, using the image above for 
reference. In this application, we will wire positions 1&2 together.
 
In the software, open the GPIO Input block. Invert one of the Logic inputs to toggle the preset.
Then connect the GPIO Input Card to the GPIO Input block, wired straight to the GPIO Output 
block, then to the Action Trigger Module. The Action Trigger Module is used to trigger presets. 

Open the Action Trigger module to select the Presets to trigger. In an OFF state, the Preset 
number is set as -1 (No preset available)

Magnetic contact closure SPDT
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GPIO Voltage Input

10k Potentiometer

In the example, the audio source will be controlled by a 10k Potentiometer.

First, wire the physical 10k Potentiometer to the physical GPIO Card, using the image above for 
reference. 

In the software, wire the GPIO Voltage Input Card to the GPIO Voltage Input block, followed by a 
Control Range Scaler, Control Linear to Log Converter, and a Voltage Controlled Amp.

Also wire the Audio Source into the Voltage Controlled Amp. The Voltage Controlled Amp will 
ultimately control the audio. 

Then wire the Voltage Controlled Amp to the Audio Output block, and Analog Audio Output 
Card.

In the design a meter is used to show the actual output.

The Voltage Controlled Amp module is configured so that when the Potentiometer is at it’s full 
potential, the audio will be at unity gain.

However, when control value is at 100% (unity gain),  the meter displays that the value is 40%. The 
reason for this is that the GPIO Card can sense approximately 30V, but only provides 12V for this 
function.

To resolve this, a Control Range Scaler is used to display the full value at 100%.
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Trigger LED light 

In the example, the LED light will indicate when it reaches a pre-determined point in the logic 
blocks.

First, wire the physical LED light to the GPIO Card, using the image above for reference.

In the software, wire the Audio source to a Audio Signal to Control module, Control to Logic 
module, then out to the GPIO Output block and GPIO Output Card. The GPIO Output Card must 
set the GPIO channel to LED assignment. (Open the GPIO Output Card block to select this). 

Click the Audio Signal to Control module and set the threshold using the Object Property menu. 
When the threshold is reached, the LED light will trigger. 

GPIO Outputs

Anode

Cathode
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Momentary sink to ground

In the example, the sequencer uses a momentary trigger for power On/Off sequence. (There are 
several ways to accomplish this function. We used this arrangement of logic for demonstrating how 
the OR block functions.) 

First, wire the physical device to the GPIO Card, using the image above for reference. 

In the software, wire the Radio button to two Delay Holds. The two Delay Holds are wired to the 
OR module; the OR module will select either Delay Hold-1 OR Delay Hold-2.  The OR module is 
then wired to the GPIO Output block and GPIO Output Card. 
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Dual momentary sink to ground

In the example, the GPIO Card will raise or lower a screen.

First, wire the physical screen to the GPIO Card, using the image above for reference. 

In the software, the Screen Radio Button module can control the screen up/down. The Screen 
Radio button has 2 nodes: one for up, and one for down. Connect two wires to the GPIO Output 
block and to the GPIO Output Card.
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Going Online 
 
Going online loads the design file to the device and allows you to make adjustments in real-time. 
Going Online is the same process as going online with any design. 
 
In order to go online, all devices must be connected and online. (Green ON indicator in Network View) 
 
To go online, you must associate the device module with the physical hardware device.

1.    In Project View, select the device module you would like to map.

2.    Right click the device module and select Map to Physical Device. 
 
3.    Detected devices with their Mac Address will list. 
       If there is more than one of the same devices in the network, the devices can be identified by  
       the Mac Address. The device Mac Address can be found in Network View.

4.    Select Load Design to Devices located at the top of the work area.

5.    A window will pop up. Check the devices that you would like to load your design to.    
       Then click OK. 

Going online may take up to several minutes. Please do not disrupt the process. The progress bar 
at the top will display the overall progress percentage. 
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AND All inputs GPIO high for GPIO high output. 

OR Any input(s) GPIO high for GPIO high output. 

NOT Output is opposite GPIO signal of input. 

NAND GPIO high output unless all inputs are GPIO high. 

NOR GPIO high output if all inputs are GPIO low. 

XOR Output GPIO low If all inputs are the same output is GPIO low, otherwise 
GPIO high. 

XNOR If all inputs are the same output is GPIO high. 

SR-Flip Flop For each trigger (low-to-high signal) at the Trigger pin, Output Q will switch 
GPIO values. The module displays the current State of the Q pin. Output /Q 
is always the opposite of Output Q. While the Set pin is GPIO high Output 
Q will be GPIO high and While the Reset I/O is GPIO high Output Q will be 
GPIO low. 

Delay When the input is GPIO high for at least the On Time (0 to 60s, 1ms steps) the 
output will be GPIO high for the on time and GPIO low for the Off Time (0 to 
60s, 1ms steps). Bypass and output State indicator features present. 

Multiplexer Route one of eight inputs to the output using the three Control I/O’s. The 
module shows the channel selected. 

De-Multiplexer Route the input to one of the eight outputs using the three Control I/O’s. The 
module shows the channel selected. 

Encoder Convert eight GPIO inputs to three binary inputs. The module shows 
encoded Channels. 

Decoder Convert three binary inputs to eight GPIO inputs. The module shows 
decoded Channels. 

Counter Each trigger (low-to-high signal) at the Trigger I/O adds one to the Count (0 
to 99999999); at Threshold (0 to 99999999) the output state becomes high. 
State indicates the current output condition. Use Force Trigger to add one to 
the count total. Force Reset and a trigger (low-to-high signal) at the Reset I/O 
will reset the Count value to zero.

GPIO Modules
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Delay Hold When the input is triggered (low-to-high signal) or the Force Trigger but-
ton is used the Delay I/O will activate for the Delay Time (0.01 to 5000s) 
as can be seen by the Delay State. After the Delay Time, The Hold I/O will 
activate for the Hold Time (0.01 to 5000s)a depicted by the Hold State. 
Loop Mode will continuously cycle the Delay and Hold for one input 
trigger (low-to-high signal). Use the Reset button to reset and Force trig-
ger to activate the module. Allow Trigger sets whether a new trigger can 
occur during an event (Delay and Hold active cycle). 

Latch Button Use the Latch button to output a GPIO high or GPIO low signal with ON/
OFF. Reverse the GPIO output with the Inverse button.

Momentary Button Creates a trigger (low-to-high, or high-to-low signal) event at the output 
with the ON/OFF key press. Reverse the GPIO output with the inverse 
button. 

Momentary Button 
with Hold Time

Creates a trigger (low-to-high, or high-to-low signal) event at the output 
with the ON/OFF key push. Hold down push button to enable ON/OFF 
function. Reverse the GPIO output with the inverse button. 

Radio Button Output a GPIO high from the output selected with Radio Button, keeping 
all other outputs are GPIO low. Reverse all GPIO outputs on the module 
with the Inverse button. 

Indicator Displays the current State of each input. 

Counter Each trigger (low-to-high signal) at the Trigger I/O adds one to the Count 
(0 to 99999999); at Threshold (0 to 99999999) the output state becomes 
high. State indicates the current output condition. Use Force Trigger to 
add one to the count total. Force Reset and a trigger (low-to-high signal) 
at the Reset I/O will reset the Count value to zero.
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Control

Control Fader A generic fader, which is used as a reference point for control modules.

Control Inverter Inverts the control signal polarity.

Control Range  
Detector

This module outputs 2 values, one for ‘in range’ and the other for ‘out of 
range’. The user edits both of these output values. 

Control Ramp When a control signal goes over a set threshold, it will raise a control 
level at a set rate on the ouptut. When the input control signal is over 
the threshold, it will lower the control output by the set rate. Selectable 
options on this ramp are: audio, log and linear. 

Control to GPIO User defined ON and OFF threshold values, which converts the control 
signal to GPIO format. The user determines the output polarity as well. 

GPIO to Control User defined ON and OFF threshold values, which converts the control 
signal to Control format. The user determines the output polarity as well. 

Audio Signal to 
Control

Converts an audio signal that is within the High and Low limits (dB) to a 
control signal after duration of the response time. This conversion can be 
done in either a linear or logarithmic mode. 

GPIO Controlled 
Mute 

Mutes the connected audio signal when a GPIO HIGH value is present on 
the control pin.

Voltage Controlled 
Amp 

Adjusts the output gain of an audio signal relative to the control value 
input.

Control Meter A simple metering tool that displays the level of the control value input 
signal. 

Acoustic Echo 
Cancellation (AEC) 

Acoustic Echo Cancellation used for VoIP/Conference telephony to re-
duce the echo effect when dealing with higher latency audio lines.
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Signal

Gain Signal level control (-100dB to +15, 0.1dB steps), 

Gain (Relative) Signal level control that adds or subtracts a set amount from a signal. 
Includes Mute, step control and min/max gain.

Meter Nullifies the signal in order to eliminate audio.

Polarity Used to reverse the phase of the signal.

Meters

RMS Meter Root Mean Square (RMS) signal meter displayed in bar graph format
RMS level (-80dB to +40dB, 0.1 steps). 

Delay 10ms (0 to 10ms, 0.01ms steps)

Delay 50ms (0 to 50ms, 0.05ms steps) 

Delay 100ms (0 to 100ms, 0.1ms steps) 

Delay 500ms (0 to 500ms, 0.5ms steps) 

Delay 1s (0 to 1s, 1ms steps) 

Delay 2s (0 to 2s, 2ms steps) 

Equalizers  

Graphic EQ Increase/decrease the EQ Level (-30dB to +15dB, 0.1dB steps) within 10, 
15 or 31 bands across the frequency range. Set the number of bands in 
Component Properties. Bypass feature included for each band. 

Parametric EQ Increase/decrease the EQ Level (-30dB to +15dB, 0.1dB steps) amount at 
the target Frequency (20Hz to 20kHz, 1 Hz steps) with roll off controlled 
by the Bandwidth (0.02 to 4oct, 0.01oct steps) setting. Up to 8 bands per 
channel, set the number of bands in Component Properties. Includes 
Bypass feature for each band.

DSP Modules
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High Shelf Filter Increase/decrease frequencies above target Frequency (20Hz to 20kHz, 1 
Hz steps) by the EQ Level (-30 to +15 dB, 0.1dB steps). Roll off controlled 
by the Bandwidth (0.01 to 4.00oct, 0.01 steps) setting. Bypass feature 
included. 

Low Shelf Filter Increase/decrease frequencies below target Frequency (20Hz to 20kHz, 1 
Hz steps) by the EQ Level (-30 to +15 dB, 0.1dB steps). Roll off controlled 
by the Bandwidth (0.01 to 4.00oct, 0.01 steps) setting. Bypass feature 
included. 

All Pass Filter 1st Or-
der

Module parameters can be saved for a schematic design into one of 
70 preset slots. Presets can only be created in design mode and can be 
saved at three different tiers: Device, Module, and Parameter. 

All Pass Filter 2nd 
Order

Unity gain filter, 180 deg. phase shift at target Frequency (20Hz-20kHz, 1 
Hz steps) with roll off controlled by the Bandwidth (0.01to 4.00oct, 0.01 
steps). Bypass feature included. 

Loudspeaker 
Management

Combines all the normally used modules for Loudspeaker Management 
in one convenient module. Select as many inputs/outputs as needed (In 
the Component Properties Menu) and alter their parameters in one easy 
place. Includes module bypass. Modules include: Delay, HPF, LPF, PEQ, 
Limiter, Gain, Mute and Polarity. 

Filters 

High Pass Filter 
6-24dB/Oct

Attenuates frequencies below target Frequency (20Hz to 20kHz, 1 Hz 
steps and with filter Type (Butterworth, Linkwitz-Riley and Bessel) and 
Slope (6 to 24dB/oct, 6dB/oct steps). Bypass feature included. 

Low Pass Filter 
6-24dB/Oct

Attenuates frequencies above target Frequency (20Hz to 20kHz, 1 Hz 
steps) with filter Type (Butterworth, Linkwitz-Riley and Bessel) and Slope 
(6 to 24dB/oct, 6dB/oct steps). Bypass feature included.

High Pass Filter 
6-48dB/Oct 

Attenuates frequencies below targetFrequency (20Hz to 20kHz, 1 Hz 
steps and with filter Type (Butterworth, Linkwitz-Riley and Bessel) and 
Slope (6 to 48dB/oct, 6dB/oct steps.) Bypass feature included. 

Low Pass Filter 
6-48dB/Oct

Attenuates frequencies above target Frequency (20Hz to 20kHz, 1 Hz 
steps) with filter Type (Butterworth, Linkwitz-Riley and Bessel) and Slope 
(6 to 48dB/oct, 6dB/oct steps). Bypass feature included. 
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Gating Auto Mixer Typically used in a conference setting where multiple MICs are in use but 
only one (or a few) should be on at any time. This module turns on MICs 
based on their input signal as compared to the level of the other MICs. 
Once a channel is activated it typically stays on until another signal is larger. 
Includes: Mute and Gain (-100 to 16 dB, 0.01dB steps), RMS Meter (-80 to 
40 dB, 0.1 dB steps) and Auto Gain meter (-100 to 0 dB, 0.1 dB steps) 
The Priority parameter ranges from 0 to 10 (with 0 being the highest and 
10 the lowest). An input channel with a higher priority needs less level to be 
gated on by increasing the input by 2 dB/priority step
The Sensitivity parameter (-16 to 12dB in 0.01dB steps) determines at what 
level the channel is gated on compared to the automatically determined 
threshold (Ex. If the sensitivity is set to -1dB, an input signal above -1dB of 
the threshold will be gated on.)
The output includes Gain (-100 to 16 dB, 0.01 dB steps) and Mute control
The time for a MIC to be gated off is set by the Hold Time (50 to 6000 ms, 
0.001ms steps). 
The Off Gain (-90 to -10 dB, 0.1dB steps) determines the gain for an off 
channel.
Last MIC On mode determines which MIC stays on when no one is talking. 
(This can be set to none, last MIC used or a specific input)
The maximum number of open (on) MICs is set by the # of Open Mic. The 
Open MIC Attenuation (0 to 6dB, 0.01 dB steps) attenuates the output by 
the set amount whenever the number of open MICs is doubled

Gain Sharing Auto 
Mixer

Allows the automatic mixing of input channels to one output channel based 
on input signal levels. The louder the particular input channel, the louder 
it will be at the output channel. Each input includes Mute, Gain (-100 to 16 
dB, 0.01dB steps), RMS Meter (-80 to 40 dB, 0.1 dB steps) and Auto Gain 
meter (-100 to 0 dB, 0.1 dB steps) (Shows calculated gain for each channel)
Manual On changes the gain from automatic (off) to fixed (on). While 
Manual On, the gain for the channel is fixed and will not affect other 
channels.
The Priority parameter ranges from 0 to 10 (with 0 being the highest and 
10 the lowest). An input channel with a higher priority will have a larger 
gain applied dependent on the Slope value and difference in priority 
between channels.
Outputs include Gain (-100 to 16 dB, 0.01 dB steps) and Mute control
The time for gain to occur is set by the Response Time (0.2 to 2000 ms, 0.1 
ms steps).
The Slope (1 to 3, 0.001 steps) determines the gain difference between 
priorities. With a Slope of 1 there is no gain. With a Slope of 2, 2dB per 
point of priority difference between channels. A Slope of 3 creates a 4dB 
gain per point of priority.
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LR Mixer Increase/decrease frequencies above target Frequency (20Hz to 20kHz, 1 Hz 
steps) by the EQ Level (-30 to +15 dB, 0.1dB steps). Roll off controlled by the 
Bandwidth (0.01 to 4.00oct, 0.01 steps) setting. Bypass feature included. 

LCR Mixer Mixes inputs before splitting into Left, Right and Centre outputs based on 
the Right Ratio. Includes Input / Output Gain, (-100dB to 15dB, 0.1dB steps), 
Mute control and input Polarity control

Mono Mixer Signal level control that adds or subtracts a set amount from a signal. 
Includes Mute, step control and min/max gain. 

Priority Selector Multiple channel input, single output. Output is the input On channel with 
highest Priority (First-Tenth) channel above the Threshold (-60dB to 0dB) 
value when Threshold Enable is activated.  Includes output Mute, Hold Time 
(10ms to 30s), signal (above threshold) and Channel Selection indicators.

Summer Summed multiple input channel audio is released as a single channel output. 

Solo Mixer Allows quick soloing of up to 64 channels that are passing through the solo 
mixer. Has both latching and exclusive modes. 

Room Combiner Allows for easy reassignment of wall controls to coincide with movable wall 
rooms creating new zone controls as configured. 

Dynamics  

Noise Gate Allows for muting of low-level input signals. 

Compressor Reduces the signal level above the Threshold (-60 to 20dB, 0.5 dB steps) 
value by the Ratio (1:1, 40:1, 1:1 steps) set. Attack (0.1 to 2000ms, 0.1ms 
steps) adjusts the time to reduce the signal once the signal has been 
exceeded. Bypass feature and RMS meter included.

Sidechain 
Compressor

Compressor with side chaining and knee control. This allows multiple 
compressors to be tied together with a reference side chained line. This 
allows the multiple compressors to be controlled from a single source for 
the control of dynamics rather than just the input. This prevents one channel 
from being greatly compressed and other channels to not be. In addition, 
the “knee span” will adjust the rate that the ratio is applied after passing over 
the threshold. I.e., if set to a ratio of 40:1, with a knee span of 5db, it will hit 
the threshold, then take 5db before it hits the full ratio. 

Peak Limiter Reduces the signal level above the Threshold (-60 to 20dB, 0.5 dB steps) 
value by 40:1. Bypass feature and RMS meter included. 
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Expander Reduces the signal level below the Threshold (-60 to 20dB, 0.1 dB steps) 
value by the Ratio (1:1, 40:1, 1:1 steps) set. Attack (0.1 to 100ms, 0.01ms 
steps) adjusts the time to reduce the signal once the signal has dropped 
below the threshold. Once the signal has risen above the threshold the 
Release (0ms to 10s, 1ms) time is the time to stop compressing the signal. 
Bypass feature and RMS meter included. 

Sidechain 
Expander

Expander with the addition of Side Chaining similar to Sidechain 
compressor. 

Ducker Attenuates channel 1 input by the Depth (0dB to 100dB, 0.01 dB steps) value 
when channel 2 surpasses the Threshold (-60dB to 0dB, 0.01 dB steps) value 
Attack (10 to 500ms, 1ms steps) adjusts the time to reduce the signal once 
the signal has been exceeded. Once the signal in channel 2 has fallen below 
the threshold the Release (10ms to 60s, 1ms steps) time is the time to stop 
attenuating the signal. The Hold Time (10ms to 10s, 1 ms steps) sets the 
period before the signal is released after channel 2 drops below threshold. 
Attenuation is shown with an RMS meter. 

Automatic Gain 
Control

Keeps the volume at a set level. When the input is below a threshold, it will 
amplify to bring the level up to the Target Output Level, and when over will 
reduce the gain to bring it back below the Target output Level.
Target Output Level (-40 to 0dB)
Detection Threshold (-80 to -20 dB) is the point at which the AGC will start to 
raise the gain of the signal.
Response Time (1ms to 40,000ms) is the period of time before the AGC 
begins to act when the level is over or under the Target output Level; Similar 
to expansion/compression
Recovery Time (1ms to 100,000ms) is the amount of time after the Target
Output level is below the set level before the AGC begins to increase the 
gain
Ratio (1:1 to 5:1) is how much the change can increase/decrease the gain 
between samples. 
Contour (HPF On/Off) allows higher frequencies to pass regardless of level. 
All AGC functions act on the lower frequency components.
Noise Threshold (-100 to -40Db) is where the noise floor can be set
Leakage Enable (On/Off) enables leakage on the ALC so that short-term 
instances of over/under the Target Output Level are ignored for this amount 
of time.
Leakage Time (100ms to 100,000ms) is how long the leakage is allowed 
before the gain starts to compensate
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ANC-Gap Sensing Used for speech & paging applications. The output level is adjusted 
automatically in response to variations in the ambient noise level. The 
ambient noise is measured in the output gaps, when no signal to the outputs 
is present, or drops to below a pre-defined threshold
Max Gain (-30 to +20db) is the limit that the ANC will raise the signal by
Min Gain (-30 to +20Db) is the lowest level that the signal will lower itself to
Speed (1-60 Seconds) is the amount of time the volume change occurs over
Gap Threshold (-60 to -20db) is the level that the module sees as the point 
where it will take a sample from the mic on the modules background input
Gap Time (1-2000ms) is the time sampled for the reference ambient noise 
level
Gap Interval (60-3600 Sec) is the period between the samples of 
background noise
Averaging Count (1-10) is how many samples are averaged to determine the 
background noise
Ambient Noise (-60 to -12dB) is the reference background noise level with 
no program material 
Pressing the ‘Update Gain’ button causes the ANC to immediately update its 
gain prior to the next scheduled reading. Pressing the “Acquire Threshold” 
button with no program source input calibrates the normal ambient level

Generators  

Sine Tone Creates a sine wave with Level (-100 to 20dB, 0.1 dB steps) and Frequency 
(20Hz to 20kHz, 1Hz steps). Includes mute control. 

Sine Sweep Creates a frequency changing sine wave with Level (-100 to 20dB, 0.1 dB 
steps), Start Frequency (20Hz to 20kHz, 1Hz steps), End Frequency (20Hz 
to20kHz, 1Hz steps), Sweep Time (1ms to 60s, 1ms steps) and Mute control. 
Repeat continuously cycles and starts the cycle from the beginning. 

White Noise Creates white noise with Level (-100 to 20dB, 0.1 dB steps) and Mute control. 

Pink Noise Creates pink noise with Level (-100 to 20dB, 0.1 dB steps) and Mute control. 
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I/O Information  

Mic/Line Gain Input signal Mic/Line Gain (-40 to 25 dB in 0.01dB steps). 

Phantom Power 48V Phantom power on/off for each MIC input. 

Mic/Line Mic/Line selection for each input. Provides hardware +40dB gain. 

Analog Input Analog input entering the DSP. Includes RMS level Meter (-80 to 40dB, 0.1dB 
steps), Gain (-100 to +15 dB, 0.1dB steps), Mute and Polarity. 

Analog Output Analog output exiting the DSP. Includes RMS level Meter (-80 to 40dB, 0.1dB 
steps), Gain (-100 to +15 dB, 0.1dB steps), Mute and Polarity. Green indicates 
active physical I/O for your processor model. 

Network Input Network input entering the DSP. Includes RMS level Meter (-80 to 40dB, 
0.1dB steps), Gain (-100 to +15 dB, 0.1dB steps), Mute and Polarity. 

Network Output Network output exiting the DSP. Includes RMS level Meter (-80 to 40dB, 
0.1dB steps), Gain (-100 to +15 dB, 0.1dB steps), Mute and Polarity. 

GPIO Input GPIO input entering the DSP. Includes Enable and Inverse control. 

GPIO Output GPIO output exiting the DSP. Includes Enable and Inverse control 
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Customer Support
If you’d like to contact us regarding product support or 
technical designs, email support@xilica.com and we’ll 
connect you with a solutions engineer Alternatively, if 
you’d like to speak to someone, you can call the following 
numbers for immediate assistance: 

International: 		  +1 905 770-0055

US Toll Free:			  +1 877 767-0234 

Europe: 			   +31 29940-1100

China & Hong Kong SAR: 	+852 2604-9382

www.xilica.com
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